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Introduction

The following conventions are used in this manual:

The » symbol leads you through nested menu items and dialog box options
to a final action. The sequence File»Page Setup»Options directs you to
pull down the File menu, select the Page Setup item, and select Options
from the last dialog box.

The ¢ symbol indicates that the following text applies only to a specific
product, a specific operating system, or a specific software version.

This icon denotes a note, which alerts you to important information.

This icon denotes a caution, which advises you of precautions to take to
avoid injury, data loss, or a system crash. When this symbol is marked on a
product, refer to the Safety and Radio-Frequency Interference Read Me
First document for information about precautions to take.

Bold text denotes items that you must select or click in the software, such
as menu items and dialog box options. Bold text also denotes parameter
names.

Italic text denotes variables, emphasis, a cross reference, or an introduction
to a key concept. This font also denotes text that is a placeholder for a word
or value that you must supply.

Text in this font denotes text or characters that you should enter from the
keyboard, sections of code, programming examples, and syntax examples.
This font is also used for the proper names of disk drives, paths, directories,
programs, subprograms, subroutines, device names, functions, operations,
variables, filenames and extensions, and code excerpts.

Italic text in this font denotes text that is a placeholder for a word or value
that you must supply.

This document contains instructions for calibrating the NI PXI/PCI-5122
digitizer (NI 5122). This calibration procedure is intended for metrology
labs. It describes specific programming steps for writing an external
calibration procedure for the NI 5122.
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What Is Calibration?

Calibration consists of verifying the measurement accuracy of a device and
correcting for any measurement error. Verification is measuring the
performance of a device and comparing the results to the specifications of
the device. NI calibrates every NI 5122 digitizer at the factory. During the
factory calibration process, the calibration constants are stored in an
onboard EEPROM. These values are loaded from this EEPROM and used
as needed by the digitizer.

The NI 5122 supports two types of calibration: self-calibration (or internal
calibration) and external calibration.

Self-Calibration

Self-calibration, also known as internal calibration, uses a software
command and requires no external connections. Self-calibration improves
measurement accuracy by compensating for variables such as temperature
that may have changed since the last external calibration. Self-calibration
retains the traceability of the external calibration.

External Calibration

External calibration is generally performed with a high-precision
oscilloscope calibrator at either NI or a metrology lab. This procedure
replaces all calibration constants in the EEPROM and is equivalent to a
factory calibration at NI. Because the external calibration procedure
changes all EEPROM constants, it invalidates the original calibration
certificate. If an external calibration is done with a traceable signal
generator source, a new calibration certificate can be issued.

Why Should You Calibrate?

The accuracy of electronic components drifts with time and temperature,
which can affect measurement accuracy as a device ages. Calibration
verifies that the digitizer still meets its specified accuracy and NI standards.
If adjustments are necessary, calibration makes the adjustments to restore
the accuracy of the digitizer.

How Often Should You Calibrate?

Self-calibration can be performed as necessary to compensate for
environmental changes.

A Caution Although you can use self-calibration repeatedly, self-calibrating the NI 5122
more than a few times a day may cause excessive wear on the relays over time.
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The measurement accuracy requirements of your application determine
how often you should externally calibrate the NI 5122. NI recommends
that you perform a complete external calibration at least once every two
years. You can shorten this interval based on the accuracy demands of your
application. Refer to the External Calibration Options section for more
information.

Software and Documentation Requirements

Software

This section describes the software and documentation required for both
self-calibration and external calibration.

Calibrating the NI 5122 requires installing NI-SCOPE version 2.6 or later
on the calibration system. You can download NI-SCOPE from the
Instrument Driver Network at ni . com/idnet. NI-SCOPE supports
programming the Self-Calibration Procedures in a number of
programming languages. However, only LabVIEW and C are supported
for the External Calibration Procedures.

NI-SCOPE 2.6 or later includes all the functions and attributes necessary
for calibrating the NI 5122. For LabWindows™/CVI™, the NI-SCOPE
function panel niScopeCal. fp provides further help on the functions
available in CVI. LabVIEW support is installed in niScopeCal.1l1lb, and
all calibration functions appear in the function palette. Refer to Table 1 for
file locations.

Calibration functions are C function calls or LabVIEW VIs in the
NI-SCOPE driver. In this document, the C function call is shown first,
followed by the corresponding LabVIEW VI in parentheses. The C
function calls are valid for any compiler capable of calling a 32-bit DLL.
Many of the functions use constants defined in the niScopecCal.h file.
To use these constants in C, you must include niScopeCal.hin your code
when you write the calibration procedure.
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For more information on the calibration functions and VIs, refer to the
NI-SCOPE Function Reference Help or the NI-SCOPE VI Reference Help.
These references can be found in the NI High-Speed Digitizers Help.

To access this help file, go to Start»Programs»National Instruments»
NI-SCOPE»Documentation»NI High-Speed Digitizers Help.

Table 1. Calibration File Locations after Installing NI-SCOPE 2.6 or Later

File Name and Location

Description

IVI\Bin\niscope_32.d1l1l

NI-SCOPE driver containing the entire
NI-SCOPE API, including calibration functions

IVI\Lib\msc\niscope.lib

NI-SCOPE library for Microsoft C containing
the entire NI-SCOPE API, including calibration
functions

LabVIEW (version) \examples\instr\
niScope

Directory of LabVIEW NI-SCOPE example
VIs, including self-calibration; access the
calibration example from the LabVIEW
function palette

LabVIEW (version)\instr.lib\niScope
Calibrate\niScopeCal.llb

LabVIEW VI library containing VIs for calling
the NI-SCOPE calibration API; access
calibration functions from the NI-SCOPE
calibration section of the LabVIEW function
palette

IVI\Drivers\niScope\niScopeCal. fp

CVI function panel file that includes external
calibration function prototypes and help on
using NI-SCOPE in the CVI environment

IVI\Include\niScopeCal.h

Calibration header file, which you must include
in any C program accessing calibration
functions. This file automatically includes
niScope.h, which defines the rest of the
NI-SCOPE interface

IVI\Drivers\niScope\Examples\

Directory of NI-SCOPE examples for CVI, C,
Visual C++, and Visual Basic

© National Instruments Corporation
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Documentation

You may find the following documentation helpful as you write your
calibration procedure:

NI High-Speed Digitizers Getting Started Guide

NI High-Speed Digitizers Help

NI PXI/PCI-5122 Specifications

NI-SCOPE Function Reference Help or NI-SCOPE VI Reference Help

These documents are installed when you install NI-SCOPE. You can also
download them from the NI Web site at ni . com/manuals.

Self-Calibration Procedures

The NI 5122 includes precise internal circuits and references it uses during
self-calibration to adjust for time and temperature drift. The digitizer gain,
offset, flatness, and trigger timing are all corrected in self-calibration.
Measuring the accuracy of these internal calibration circuits with another
instrument during external calibration provides traceability for the
verification procedure. Absolute accuracy is ensured by compensating
for any error measured in the internal references.

@ Note Self-calibrate the digitizer before you perform verification. NI-SCOPE includes
self-calibration example programs for LabVIEW, CVI, and Microsoft Visual C.

You can initiate self-calibration using Measurement & Automation
Explorer (MAX), using the Scope Soft Front Panel (SFP), or
programmatically using NI-SCOPE.

MAX

To initiate self-calibration from MAX, complete the following steps:

1.

2
3.
4.
5

NI PXI/PCI-5122 Calibration Procedure

Disconnect or disable any AC inputs to the digitizer.

Launch MAX.

Select My System»Devices and Interfaces»NI-DAQmx Devices.
Select the device that you want to calibrate.

Initiate self-calibration using one of the following methods:

*  Click Self-Calibrate in the upper right corner of MAX.

*  Right-click on the device and select Self-Calibrate from the
drop-down menu.
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Scope SFP

To initiate self-calibration from the Scope SFP, complete the following
steps:

1.

NI-SCOPE

Launch the Scope SFP (Start»Programs»National Instruments»
NI-SCOPE»Scope Soft Front Panel).

Select the device you want to calibrate using the Device Configuration
dialog box (Edit»Device Configuration).

Launch the Calibration dialog (Utility»Self Calibration).
Disconnect or disable any AC inputs to the digitizer.

Click OK to begin self-calibration.

To self-calibrate the NI 5122 programmatically using NI-SCOPE,
complete the following steps:

1.
2.

© National Instruments Corporation

Disconnect or disable any AC inputs to the digitizer.

Call niScope_init (niScope Initialize VI) to obtain an instrument
session handle. Set the following parameters:

* resourceName: The device name assigned by MAX
e IDQuery: NISCOPE_VAIL_VI_FALSE
e resetDevice: NISCOPE_VAL_VI_FALSE

e vi: The returned session handle that you use to identify the
instrument in all subsequent instrument driver function calls

Call niScope_calSelfcalibrate (niScope Cal Self Calibrate VI)
with the following parameters:

* sessionHandle: The instrument handle that you obtain from
niScope_init (niScope Initialize VI)

¢ channelList: vI_NULL
e option: VI_NULL

Because the session is a standard session rather than an external
calibration session, the new calibration constants are immediately
stored in the EEPROM. Therefore, you can include this procedure in
any application that uses the digitizer.

Call niscope_close (niScope Close VI) to close the session handle.
Set the following parameter:

e vi: The instrument handle you obtained from niScope_init
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External Calibration Options

External calibration involves both adjustment and verification. Adjustment
is the process of measuring and compensating for device performance to
improve the measurement accuracy. Performing an adjustment updates the
calibration date, effectively resetting the calibration interval. The device is
guaranteed to meet or exceed its published specifications for the duration
of the calibration interval. Verification is the process of testing the device
to ensure that the measurement accuracy is within certain specifications.
Verification can be used to ensure that the adjustment process was
successful, or to determine if the adjustment process needs to be performed
at all. During verification, you must compare the measurement error to
limits given in Tables 4 through 8.

This document provides two sets of test limits for most verification
stages—the calibration test limits and the published specifications. The
calibration test limits are more restrictive than the published specifications.
If all of the measurement errors determined during verification fall within
the calibration test limits, the device is guaranteed to meet or exceed its
published specifications for a full calibration interval (two years). For this
reason, you must verify against the calibration test limits when performing
verification after adjustment. If all of the measurement errors determined
during verification fall within the published specifications, but not within
the calibration test limits, the device is meeting its published specifications.
However, the device will not necessarily remain within these specifications
for an additional two years. The device will meet published specifications
for the remainder of the current calibration interval. In this case, you can
perform an adjustment if you want to further improve the measurement
accuracy or reset the calibration interval. If some measurement errors
determined during verification do not fall within the published
specifications, you must perform an adjustment to restore the device
operation to its published specifications.

The Complete Calibration section describes the recommended calibration
procedure. The Optional Calibration section describes alternate
procedures that allow you to skip adjustment if the device already meets its
calibration test limits or published specifications.
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Complete Calibration

Performing a complete calibration is the recommended way to guarantee
that the NI 5122 will meet or exceed its published specifications for a
two-year calibration interval. At the end of the complete calibration
procedure, you verify that the measurement error falls within the
calibration test limits. Figure 1 shows the programming flow for complete
calibration.

Self-Calibrate

y Document
Verif ~ | Pre-Adjustment
Y g Results

\4

Adjust (Cal Dates and
Temperatures Updated)

A4 Document
Post-Adjustment
Results

Meets
Calibration
Test Limits?

Yes

A4

Review Verification/
Adjustment Procedure
or Return Device

Calibration/
Verification
Complete

Figure 1. Complete Calibration Programming Flow
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Optional Calibration

5

Note

You can choose to skip the adjustment steps of the calibration procedure if
the measurement error is within the calibration test limits or the published
specifications during the first verification. If all of the measurement errors
determined during the first verification fall within the calibration test
limits, the device is guaranteed to meet or exceed its published
specifications for a full calibration interval. In this case, you can update the
calibration date, effectively resetting the calibration interval, without
actually performing an adjustment. Refer to the Adjusting the NI 5122
section for more information.

If all of the measurement errors determined during the first verification fall
within the published specifications, but not within the calibration test
limits, adjustment is also optional. However, you cannot update the
calibration date, because the device will not necessarily operate within the
published specifications for an additional two years.

Regardless of the results of the first verification, if you choose to perform an

adjustment, you must verify that the measurement error falls within the calibration test
limits at the end of the calibration procedure.

Figure 2 shows the programming flow for the optional calibration.
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Self-Calibrate

y Document
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Calibration
Test Limits?

Yes
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Published
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(Adjustment
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v
Update Calibration
Dates and Temperatures
Without Adjusting

v

Adjust (Cal Dates and
Temperatures Updated)

Adjust
Anyway?

\ 4
Verify
Y
Document
Post-Adjustment

Results

Meets
Calibration
Test Limits?

Yes

Calibrm

—»| Verification
Complete

A

Review Verification/
Adjustment Procedure
or Return Device

Figure 2. Optional Calibration Programming Flow
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External Calibration Requirements

Test Equipment

Table 2 lists the equipment required for externally calibrating the NI 5122.
If you do not have the recommended instruments, use these specifications
to select a substitute calibration standard.

Table 2. Required Equipment Specifications for NI 5122 External Calibration

Required Recommended Parameter
Equipment Equipment Measured Specification

Signal Generator Fluke 9500B Vertical Gain DC +(0.025% + 25 uV) into 1 MQ

oscilloscope or 50 Q
librat

catibrator Bandwidth +1.5% output amplitude flatness
(Wavetek 9500 for leveled sine wave up to
with high-stability 100 MHz relative to 50 kHz into
reference option) 1 MQ or 50 Q
9510 Test Head Timing 2 ppm frequency accuracy

BNC cable — — 50 Q

Test Conditions

NI PXI/PCI-5122 Calibration Procedure

Follow these guidelines to optimize the connections and the environment
during calibration:

Always connect the calibrator test head directly to the input BNC of
the digitizer, or use a short 50 Q BNC coaxial cable if necessary. Long
cables and wires act as antennae, picking up extra noise that can affect
measurements.

Keep relative humidity between 10 and 90% non-condensing, or
consult the digitizer hardware documentation for the optimum relative
humidity.

Maintain an ambient temperature of 23 +5 °C.

Allow a warm-up time of at least 15 minutes after the NI-SCOPE
driver is loaded. Unless manually disabled, the NI-SCOPE driver
automatically loads with the operating system and enables the device.
The warm-up time ensures that the measurement circuitry of the

NI 5122 is at a stable operating temperature.
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¢ For PXI digitizers:

*  Ensure that the PXI chassis fan speed is set to HI, that the fan filters are
clean, and that the empty slots contain filler panels.

e Plug the PXI chassis and the calibrator into the same power strip to
avoid ground loops.
¢ For PCI digitizers:

e  Plug the PC and the calibrator into the same power strip to avoid
ground loops.

External Calibration Procedures

The complete external calibration procedure consists of self-calibrating,
verifying the performance of the digitizer, adjusting the calibration
constants, and verifying again after the adjustments. In some cases, the
complete calibration procedure may not be required. Refer to the External
Calibration Options section for more information.

The external calibration procedure automatically stores the calibration date
to allow traceability.

Verifying NI 5122 Specifications

@ Note Always self-calibrate the NI 5122 before beginning a verification procedure.

This section describes the program you must write to verify either the
calibration test limits or the published specifications for the NI 5122. Refer
to the External Calibration Options section to determine which limits to
use in these procedures.

All verification procedures described in this section begin with
niScope_init (niScope Initialize VI) with resetDevice set to
NISCOPE_VAL_TRUE, and end with niScope_close (niScope Close VI).

E Note If any of these tests fail immediately after you perform an external adjustment, verify
that you have met the required test conditions before you return the digitizer to NI for
repair.

Vertical Offset and Vertical Gain Accuracy

Table 3 contains the input parameters for verifying both vertical offset
accuracy and vertical gain accuracy of the NI 5122.

To verify vertical offset accuracy, complete the procedures described in the
Vertical Offset Accuracy section for each of the 39 iterations listed in
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Table 3, then repeat the procedure for channel 1. The calibration test limits

and published specifications are shown in Table 4.

To verify vertical gain accuracy, complete the procedures described in the
Vertical Gain Accuracy section for each of the 39 iterations listed in
Table 3, then repeat the procedure for channel 1. The calibration test limits

and published specifications are shown in Table 5.

Table 3. Input Parameters for Vertical Offset Accuracy and Vertical Gain Accuracy Verification

Iteration Input Impedance Max Input Frequency (Hz) Range (V)
1 50 Q 100,000,000 0.2
2 50Q 100,000,000 04
3 50 Q 100,000,000 1
4 50Q 100,000,000 2
5 50 Q 100,000,000 4
6 50 Q 100,000,000 10
7 50 Q 35,000,000 0.2
8 50 Q 35,000,000 04
9 50 Q 35,000,000 1
10 50 Q 35,000,000 2
11 50 Q 35,000,000 4
12 50Q 35,000,000 10
13 50 Q 20,000,000 0.2
14 50 Q 20,000,000 04
15 50Q 20,000,000 1
16 50 Q 20,000,000 2
17 50 Q 20,000,000 4
18 50 Q 20,000,000 10
19 1 MQ 100,000,000 0.2
20 1 MQ 100,000,000 04
21 1 MQ 100,000,000 1
22 1 MQ 100,000,000 2
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Table 3. Input Parameters for Vertical Offset Accuracy and Vertical Gain Accuracy Verification (Continued)

Iteration Input Impedance Max Input Frequency (Hz) Range (V)
23 1 MQ 100,000,000 4
24 1 MQ 100,000,000 10
25 1 MQ 100,000,000 20
26 1 MQ 35,000,000 0.2
27 1 MQ 35,000,000 0.4
28 1 MQ 35,000,000 1
29 1 MQ 35,000,000 2
30 1 MQ 35,000,000 4
31 1 MQ 35,000,000 10
32 1 MQ 35,000,000 20
33 1 MQ 20,000,000 0.2
34 1 MQ 20,000,000 0.4
35 1 MQ 20,000,000 1
36 1 MQ 20,000,000 2
37 1 MQ 20,000,000 4
38 1 MQ 20,000,000 10
39 1 MQ 20,000,000 20

Vertical Offset Accuracy

To verify vertical offset accuracy, complete steps 1 through 8 for each of
the 39 configuration iterations listed in Table 3.

1. Call niScope_ConfigureChanCharacteristics
(niScope Configure Chan Characteristics VI) with the following
parameters:

e channelList: "0"

e inputImpedance: The Input Impedance value for the current
iteration from Table 3

* maxInputFrequency: The Max Input Frequency value for the
current iteration from Table 3

© National Instruments Corporation 15 NI PXI/PCI-5122 Calibration Procedure



2. Call niscope_Configurevertical (niScope Configure
Vertical VI) with the following parameters:

* channelList: "0"

* range: The Range value for the current iteration from Table 3
o offset: 0.0

e coupling: NISCOPE_VAL_DC

*  probeAttenuation: 1.0

* enabled: NISCOPE_VAL_TRUE

3. CallniScope_ConfigureHorizontalTiming (niScope Configure
Horizontal Timing VI) with the following parameters:

* minSampleRate: 10,000,000

¢ minNumPts: 100,000

¢ refPosition: 50.0

¢ numRecords: 1

¢ enforceRealtime: NTSCOPE_VAL_TRUE

4. Call niscope_Commit (niScope Commit VI) with the following
parameter:

e vi: The instrument handle you obtained from niScope_init

5. Short-circuit the channel O input of the digitizer by connecting the
calibrator test head directly to the digitizer and grounding the output of
the calibrator.

6. Wait 50 ms for calibrator’s impedance matching to settle.

7. CallniScope_InitiateAcquisition. (niScope Initiate
Acquisition VI) with the following parameter:

e vi: The instrument handle you obtained from niScope_init

8. Call niscope_FetchMeasurement (niScope Fetch
Measurement VI) with the following parameters:

e channelList: "0"
e timeout: 1.0
¢ scalarMeasFunction: NISCOPE_VAL_VOLTAGE_AVERAGE

Compare the resulting average voltage to the value in the Calibration
Test Limits column or the Published Specifications column in Table 4
that corresponds to the vertical range used. The inputImpedance and
maxInputFrequency do not affect the test limit value. If the result is
within the selected test limit, the device has passed this portion of the
verification.

@ Note 50 Q input impedance with 20 V range is not a valid configuration.
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Move the calibrator test head to the digitizer input channel 1 and repeat
steps 1 through 8 for every configuration in Table 3, replacing "0" with
"1" for the channelList parameter.

Table 4. NI 5122 Vertical Offset Calibration Test Limits and Published Specifications

Range Calibration Test Limits | Published Specifications
(V) (V) V)
0.2 +0.00057 +0.001
0.4 +0.00057 +0.001
1 +0.00057 +0.001
2 +0.00057 +0.001
4 +0.0033 +0.008
10 +0.0033 +0.008
20 +0.0039 +0.01

You have finished verifying the vertical offset accuracy of the NI 5122.

Vertical Gain Accuracy

To verify vertical gain accuracy, complete steps 1 through 11 for each of
the 39 configuration iterations in Table 3.

1. Call niScope_ConfigureChanCharacteristics
(niScope Configure Chan Characteristics VI) with the following

parameters:

e channelList: "0"

* inputImpedance: The Input Impedance value for the current
iteration from Table 3

*  maxInputFrequency: The Max Input Frequency value for the
current iteration from Table 3

2. Call niscope_ConfigureVertical (niScope Configure
Vertical VI) with the following parameters:

¢ channelList: "0"

* range: The Range value for the current iteration from Table 3
e offset: 0.0

e coupling: NISCOPE_VAL_DC

e probeAttenuation: 1.0

e enabled: NISCOPE_VAL_TRUE

© National Instruments Corporation
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10.

11.

NI PXI/PCI-5122 Calibration Procedure

Call niScope_ConfigureHorizontalTiming (niScope Configure
Horizontal Timing VI) with the following parameters:

* minSampleRate: 10,000,000

e minNumPts: 100,000

e refPosition: 50.0

*  numRecords: 1

¢ enforceRealtime: NISCOPE_VAL_TRUE

Call niScope_Commit (niScope Commit VI) with the following
parameter:

e vi: The instrument handle you obtained from niScope_init

Connect the calibrator test head directly to the channel O input of the

digitizer and output the positive voltage from Table 5 that corresponds
to the vertical range used. Be sure to configure the load impedance of
the calibrator to match the input impedance of the digitizer.

Wait 2,500 ms for the calibrator’s impedance matching to settle.

Call niScope_InitiateAcquisition (niScope Initiate
Acquisition VI) with the following parameter:

e vi: The instrument handle you obtained from niScope_init

Call niScope_FetchMeasurement (niScope Fetch
Measurement VI) with the following parameters:

¢ channelList: "0"

* timeout: 1.0

e scalarMeasFunction: NISCOPE_VAL_VOLTAGE_AVERAGE
Output the negative voltage listed in Table 5 with the calibrator.

Call niScope_FetchMeasurement (niScope Fetch
Measurement VI) with the following parameters:

¢ channelList: "0"
e timeout: 1.0
¢ scalarMeasFunction: NISCOPE_VAL_VOLTAGE_AVERAGE

Compute the error in the vertical gain as a percentage of input using
the formula:

error = (((a—b) / (c —d)) — 1) * 100

where a is the measured positive voltage, b is the measured negative
voltage, c is the applied positive voltage, and d is the applied negative
voltage.

Compare the resulting percent error to the Calibration Test Limits or
the Published Specifications listed in Table 5. If the result is within the
selected test limit, the device has passed this portion of the verification.
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Table 5. Vertical Gain Stimuli, Calibration Test Limits, and Published Specifications

Range Positive Negative Calibration Published
V) Input (V) Input (V) Test Limits | Specifications
0.2 0.09 -0.09 +0.37% +0.65%
0.4 0.18 -0.18 +0.37% +0.65%

1 0.45 -0.45 +0.37% +0.65%
2 0.9 -0.9 +0.37% +0.65%
4 1.8 -1.8 +0.37% +0.65%
10 4.5 —4.5 +0.37% +0.65%
20 9 -9 +0.37% +0.65%

Move the calibrator test head to the digitizer input channel 1 and repeat
steps 1 through 11 for every configuration in Table 3, replacing "0" with
"1 for the channelList parameter.

You have finished verifying the vertical gain accuracy of the NI 5122.

Programmable Vertical Offset Accuracy

Complete the following steps to verify the programmable vertical offset
accuracy for each digitizer channel:

1. Call niScope_ConfigureChanCharacteristics
(niScope Configure Chan Characteristics VI) with the following
parameters:

e channelList: "0"
e inputlmpedance: NISCOPE_VAL_50_OHM
*  maxInputFrequency: 100,000,000

2. Call niscope_ConfigureVertical (niScope Configure
Vertical VI) with the following parameters:

e channelList: "0"

* range: 2.0

e offset: 0.75

e coupling: NISCOPE_VAL_DC
e probeAttenuation: 1.0

e enabled: NISCOPE_VAL_TRUE
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10.

11.

12.
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Call niScope_ConfigureHorizontalTiming (niScope Configure
Horizontal Timing VI) with the following parameters:

¢ minSampleRate: 10,000,000

e minNumPts: 100,000

¢ refPosition: 50.0

*  numRecords: 1

¢ enforceRealtime: NTSCOPE_VAL_TRUE

Call niScope_Commit (niScope Commit VI) with the following
parameter:

e vi: The instrument handle you obtained from niScope_init

Connect the calibrator test head directly to the channel O input of the
digitizer and output 0.75 V with a 50 Q load impedance.

Wait 2,500 ms for the calibrator’s impedance matching to settle.

Call niScope_InitiateAcquisition (niScope Initiate
Acquisition VI) with the following parameter:

e vi: The instrument handle you obtained from niScope_init

Call niScope_FetchMeasurement (niScope Fetch
Measurement VI) with the following parameters:

¢ channelList: "0"

e timeout: 1.0

e scalarMeasFunction: NISCOPE_VAL_VOLTAGE_AVERAGE
Output —0.75 V with the calibrator.

Call niscope_Configurevertical (niScope Configure
Vertical VI) with the following parameters:

¢ channelList: "0"

* range: 2.0

o offset: —0.75

e coupling: NISCOPE_VAL_DC

*  probeAttenuation: 1.0

e enabled: NISCOPE_VAL_TRUE

Call niScope_InitiateAcquisition (niScope Initiate
Acquisition VI) with the following parameter:

e vi: The instrument handle you obtained from niScope_init

Call niScope_FetchMeasurement (niScope Fetch
Measurement VI) with the following parameters:

e channelList: "0"
e timeout: 1.0

¢ scalarMeasFunction: NISCOPE_VAL_VOLTAGE_AVERAGE
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13.

Compute the error in the programmable vertical offset as a percentage
of input using the formula:

error = (((a—b)/1.5)-1) * 100

where a is the measured positive voltage and b is the measured
negative voltage.

Compare the resulting percent to the Calibration Test Limits or the
Published Specifications listed in Table 6. If the result is within the
selected test limit, the device has passed this portion of the verification.

Table 6. NI 5122 Programmable Vertical Offset Accuracy

Calibration Test Limits Published Specifications

+0.36% +0.4%

14.

Move the calibrator test head to the digitizer input channel 1 and repeat
steps 1 through 13, replacing "0" with "1" for the channelList
parameter.

You have finished verifying the programmable vertical offset accuracy of
the NI 5122.

Timing Accuracy
Complete the following steps to verify the timing accuracy for the NI 5122:

1.

© National Instruments Corporation

Call niScope_ConfigureChanCharacteristics
(niScope Configure Chan Characteristics VI) with the following
parameters:

¢ channelList: "0"
e inputlmpedance: NISCOPE_VAL_50_OHM
*  maxInputFrequency: 20,000, 000

Call niScope_ConfigureVertical (niScope Configure
Vertical VI) with the following parameters:

e channelList: "0"

* range: 2.0

e offset: 0.0

e coupling: NISCOPE_VAL_DC
e probeAttenuation: 1.0

e enabled: NISCOPE_VAL_TRUE
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3. CallniScope_ConfigureHorizontalTiming (niScope Configure
Horizontal Timing VI) with the following parameters:

¢ minSampleRate: 100,000,000

¢ minNumPts: 1,000,000

e refPosition: 50.0

*  numRecords: 1

¢ enforceRealtime: NISCOPE_VAL_TRUE

4. Call niscope_Commit (niScope Commit VI) with the following
parameter:

e vi: The instrument handle you obtained from niScope_init

5. Connect the calibrator test head directly to the channel O input of the
digitizer. Configure the calibrator to output an exact 11 MHz sine wave
with 1 V peak-to-peak amplitude and 50 € load impedance.

6. Wait 250 ms for calibrator impedance matching and frequency to
settle.

7. CallniScope_InitiateAcquisition (niScope Initiate
Acquisition VI) with the following parameter:

e vi: The instrument handle you obtained from niScope_init

8. Call niscope_FetchMeasurement (niScope Fetch
Measurement VI) with the following parameters:

* channelList: "0"
e timeout: 1.0
* scalarMeasFunction: NISCOPE_VAL_FFT_FREQUENCY
9. Compute the error in timing as parts per million (ppm) using the
formula:
error = (a — 11,000,000) / 11
where a is the measured frequency.

Compare the result to the Calibration Test Limits or the Published
Specifications listed in Table 7. If the result is within the selected test
limit, the device has passed this portion of the verification.

Table 7. Timing Accuracy

Calibration Test Limits Published Specifications
+5.3 ppm +25 ppm
@ Note The same time source is used for both channel 0 and channel 1, so you only need to

verify the timing accuracy on one channel.
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You have finished verifying the timing accuracy of the NI 5122.

Bandwidth and Flatness

Complete the following steps for each of the six configurations listed in
Table 8 to verify the bandwidth and flatness for each digitizer channel:

1.
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Call niScope_ConfigureChanCharacteristics
(niScope Configure Chan Characteristics VI) with the following
parameters:

e channelList: "0"

e inputImpedance: The Input Impedance value for the current
iteration in Table 8

*  maxInputFrequency: The Max Input Frequency for the current
iteration in Table 8

Call niScope_Configurevertical (niScope Configure
Vertical VI) with the following parameters:

e channelList: "0"

* range: The Range value for the current iteration in Table 8
o offset: 0.0

e coupling: NISCOPE_VAL_DC

* probeAttenuation: 1.0

* enabled: NISCOPE_VAL_TRUE

Call niScope_ConfigureHorizontalTiming (niScope Configure
Horizontal Timing VI) with the following parameters:

¢ minSampleRate: 10,000,000

e minNumPts: 30,000

¢ refPosition: 50.0

e numRecords: 1

¢ enforceRealtime: NISCOPE_VAIL_TRUE

Call niScope_Commit (niScope Commit VI) with the following
parameter:

¢ vi: The instrument handle you obtained from niScope_init

Connect the calibrator test head directly to the channel O input of the
digitizer. Configure the calibrator to output a 50 kHz sine wave with
peak-to-peak voltage amplitude set to half the vertical range of the
digitizer. Configure the load impedance of the calibrator to match the
input impedance of the digitizer.

Wait 250 ms for calibrator’s impedance matching to settle.
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7. CallniScope_InitiateAcquisition (niScope Initiate
Acquisition VI) with the following parameter:

e vi: The instrument handle you obtained from niScope_init

8. Call niscope_FetchMeasurement (niScope Fetch
Measurement VI) with the following parameters:

¢ channelList: "0"
e timeout: 1.0
¢ scalarMeasFunction: NISCOPE_VAL_VOLTAGE_RMS

9. CallniScope_ConfigureHorizontalTiming (niScope Configure
Horizontal Timing VI) with the following parameters:

*  minSampleRate: 100,000,000

¢ minNumPts: 300,000

e refPosition: 50.0

*  numRecords: 1

e enforceRealtime: NISCOPE_VAL_TRUE

10. Repeat steps 10a through 10d for each Input Frequency listed for the
current iteration in Table 8.

a. Configure the calibrator to output the Input Frequency for the
current iteration from Table 8.

b. CallniScope_InitiateAcquisition (niScope Initiate
Acquisition VI) with the following parameter:

e vi: The instrument handle you obtained from niScope_init

c. CallniScope_FetchMeasurement (niScope Fetch
Measurement VI) with the following parameters:

e channelList: "0"
e timeout: 1.0
e scalarMeasFunction: NISCOPE_VAL_VOLTAGE_RMS

d. Compute the power difference using the formula:

power = (20log;( a) — (20log; b)

where a is the measured RMS voltage in step 12 and b is the
measured RMS voltage in step 8.

If the result is within the test limits from Table 8, the device has
passed this portion of the verification.

Move the calibrator test head to the digitizer input channel 1 and repeat
steps 1 through 10, replacing "0" with "1 " for the channelList parameter.

NI PXI/PCI-5122 Calibration Procedure 24 ni.com



Table 8. NI 5122 Bandwidth and Flatness Stimuli and Limits

Calibration Published
Test Limits Specifications
Input Max Min Max Min
Max Input Input Range Frequency Level Level Level Level
Iteration | Frequency | Impedance V) (Hz) (dB) (dB) (dB) (dB)
1 100 MHz 50 Q 0.2 20,100,000 0.27 -0.27 0.4 -0.4
40,100,000 0.77 -0.77 1 -1
84,400,000 3 -3 3at -3 at
80 MHz 80 MHz
2 100 MHz 50 Q 0.4 20,100,000 0.27 -0.27 0.4 -0.4
50,100,000 0.77 -0.77 1 -1
103,700,000 3 -3 3at -3 at
100 MHz | 100 MHz
3 100 MHz 1 MQ 0.2 20,100,000 0.27 -0.27 0.4 -04
40,100,000 0.77 -0.77 1 -1
84,400,000 3 -3 3at -3 at
80 MHz 80 MHz
4 100 MHz 1 MQ 0.4 20,100,000 0.27 -0.27 0.4 -04
50,100,000 0.77 -0.77 1 -1
103,700,000 3 -3 3at -3 at
100 MHz | 100 MHz
5 35 MHz 50 Q 0.4 16,100,000 1.05 -1.05 1.2 -1.2
32,100,000 1.27 -1.27 1.6 -1.6
36,100,000 3 -3 3at -3 at
35 MHz 35 MHz
6 20 MHz 50 Q 0.4 15,100,000 -0.68 -2.72 -0.4 -3
20,100,000 -1.65 —4.35 -13 —4.7

You have finished verifying the bandwidth and flatness of the NI 5122.
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Adjusting the NI 5122

If the NI 5122 successfully passed each of the verification procedures
within the calibration test limits, then an adjustment is recommended but
not required to guarantee its published specifications for the next two years.
If the digitizer was not within the calibration test limits for each of the
verification procedures, you can perform the adjustment procedure to
improve the accuracy of the digitizer. Refer to the External Calibration
Options section to determine which procedures to perform.

An adjustment is required only once every two years. Following the
adjustment procedure automatically updates the calibration date and
temperature in the EEPROM of the digitizer.

@ Note If the digitizer passed the entire verification procedure within the calibration test
limits and you do not want to perform an adjustment, you can update the calibration date
and onboard calibration temperature without making any adjustments by completing only
steps 3 and 9 in this section.

Complete all of the following steps to externally adjust the NI 5122:

1.

Using a BNC cable, connect REF FREQUENCY OUTPUT on the
back of the calibrator to the channel O input of the digitizer. Make sure
the output of the reference frequency is enabled on the calibrator.
Connect the calibrator test head directly to the channel 1 input of the
digitizer. Configure the calibrator to output an exact 4 V DC signal
into a 1 MQ load impedance.

Wait 250 ms for the calibrator impedance matching to settle.

Call niscope_calStart (niScope Cal Start VI) using the user
password. The factory default password for the NI 5122 is NT.

Call niScope_Caladjustvcxo (niScope Cal Adjust VCXO VI)
with the following parameter:

e stimulusFreq: 10,000,000

@ Note The 10 MHz stimulus is automatically taken from channel 0.

NI PXI/PCI-5122 Calibration Procedure

Call niScope_CaladjustRange (niScope Cal Adjust Range VI)
with the following parameters:

¢ channelName: "1"
* range: 0
e stimulus: 4.0

Configure the calibrator to ground its output.
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7. Call niScope_CaladjustRange (niScope Cal Adjust Range VI)
with the following parameters:

¢ channelName: "1"
e range: 0
e stimulus: 0.0

8. Call niscope_calselfcalibrate (niScope Cal Self Calibrate VI)
with the following parameters:

e channelList: VI_NULL
e option: VI_NULL
9. Call niScope_CalEnd with the following parameters:

* sessionHandle: The instrument handle you obtained from
niScope_CalStart

e action: NISCOPE_VAL_ACTION_STORE to save the results of the
calibration

You have finished adjusting the NI 5122. It is not necessary to adjust each
channel individually. However, you should repeat the entire verification
procedure to verify a successful adjustment.

Calibration Utilities

NI-SCOPE supports several calibration utilities that allow you to retrieve
information about adjustments performed on the NI 5122, change the
external calibration password, and store small amounts of information in
the onboard EEPROM. You can retrieve some data using MAX, however,
you can retrieve all the data programmatically using NI-SCOPE functions.

MAX

To retrieve data using MAX, complete the following steps:

1. Select the device from which you wish to retrieve information from
My System»Devices and Interfaces»NI-DAQmx Devices.

2. Select the Calibration tab in the lower right corner.

You should see information about the last date and temperature for both
external and self-calibration.
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NI-SCOPE

NI-SCOPE provides a full complement of calibration utility functions
and VIs. Refer to the NI High-Speed Digitizers Help for the complete
function reference and VI reference. The utility functions include:

* niScope_CalChangePassword (niScope Cal Change Password VI)
* niScope_CalFetchCount (niScope Cal Fetch Count VI)

* niScope_CalFetchDate (niScope Cal Fetch Date VI)

* niScope_CalFetchMiscInfo (niScope Cal Fetch Misc Info VI)

* niScope_CalFetchTemperature (niScope Cal Fetch
Temperature VI)

* niScope_CalStoreMiscInfo (niScope Cal Store Misc Info VI)

Calibration Function References

The functions used in this procedure, including all calibration functions,
are documented in the NI-SCOPE Function Reference Help and the
NI-SCOPE VI Reference Help, both of which you can access from the
NI High-Speed Digitizers Help (Start»>Programs»National
Instruments»NI-SCOPE»Documentation).

Technical Support Resources

NI Web Support

National Instruments Web support is your first stop for help in solving
installation, configuration, and application problems and questions. Online
problem-solving and diagnostic resources include frequently asked
questions, knowledge bases, product-specific troubleshooting wizards,
manuals, drivers, software updates, and more. Web support is available
through the Technical Support section of ni . com.

A Declaration of Conformity (DoC) is our claim of compliance with the
Council of the European Communities using the manufacturer’s
declaration of conformity. This system affords the user protection for
electronic compatibility (EMC) and product safety. You can obtain the DoC
for your product by visiting ni . com/hardref .ns€£. If your product
supports calibration, you can obtain the calibration certificate for your
product at ni.com/calibration.
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Worldwide Support

National Instruments corporate headquarters is located at

11500 North Mopac Expressway, Austin, Texas, 78759-3504.

National Instruments also has offices located around the world to help
address your support needs. You can access our branch office Web sites
from the Worldwide Offices section of ni . com. Branch office Web sites
provide up-to-date contact information, support phone numbers, email
addresses, and current events.

If you have searched the technical support resources on our Web site

and still cannot find the answers you need, contact your local office or
National Instruments corporate. For telephone support in the United States,
dial 512 795 8248. For telephone support outside the United States, contact
your local branch office:

Australia 1800 300 800, Austria 43 0 662 45 79 90 0, Belgium 32 0 2 757 00 20,
Brazil 55 11 3262 3599, Canada (Calgary) 403 274 9391,

Canada (Ottawa) 613 233 5949, Canada (Québec) 450 510 3055,

Canada (Toronto) 905 785 0085, Canada (Vancouver) 514 685 7530,

China 86 21 6555 7838, Czech Republic 420 224 235 774,

Denmark 45 45 76 26 00, Finland 385 09 725 725 11, France 33 0 1 48 14 24 24,
Germany 49 0 89 741 31 30, Greece 30 2 10 42 96 427, India 91 80 51190000,
Israel 972 0 3 6393737, Italy 39 02 413091, Japan 81 3 5472 2970,

Korea 82 02 3451 3400, Malaysia 603 9131 0918, Mexico 001 800 010 0793,
Netherlands 31 0 348 433 466, New Zealand 0800 553 322,

Norway 47 0 66 90 76 60, Poland 48 22 3390150, Portugal 351 210 311 210,
Russia 7 095 783 68 51, Singapore 65 6226 5886, Slovenia 386 3 425 4200,
South Africa 27 0 11 805 8197, Spain 34 91 640 0085, Sweden 46 0 8 587 895 00,
Switzerland 41 56 200 51 51, Taiwan 886 2 2528 7227, Thailand 662 992 7519,
United Kingdom 44 0 1635 523545

CVI™, [VI™, LabVIEW™, National Instruments™, NI™, ni.com™, and NI-DAQ™ are trademarks of
National Instruments Corporation. Product and company names mentioned herein are trademarks or
trade names of their respective companies. For patents covering National Instruments products, refer

to the appropriate location: Help»Patents in your software, the patents. txt file on your CD, or
ni.com/patents.
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